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SDDS SETUP SOFTWARE USER’S MANUAL REVISION 2

1. INTRODUCTION

The SDDS Setup Software is used to adjust the settings of the DFP-D2000
Digital Film Sound Decoder. DFP settings are adjusted through a Windows
based interface using either mouse or keyboard input. In addition to adjusting
DFP settings, the SDDS Setup Software can also be used to monitor the
operating status of the Decoder and Reader while film is running.

This manual covers the operation of the SDDS Setup Software.

Detailed Information regarding Installation and Operation of the SDDS Film
Playback System is covered respectively in the SDDS Instaliation and SDDS
Operation Manuals.

2. REQUIREMENTS

To ensure the proper operation of the SDDS Setup Software, the PC or PC
laptop must have the following minimum configuration.

1. MHz or higher processor (486 recommended)

2. A minimum of 4 Mbytes of RAM (8 -Mbytes of RAM recommended)
3. Atleast 20 Mbytes of availabie Hard disk.space

4. Windows 3.1 or Windows for Workgroups 3.11

5. One serial interface port

6. Null Modem cable for connection between the PC and the DFP

t - -y

7. A mouse or trackball pointing device (if using a laptop)

8. (Optional) A 9600 baud modem. Contact your SDDS representative for
details regarding modem communications with the DFP 2000 processor.
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3. INSTALLATION

1. To ensure proper operation of the SDDS Setup Software, install the software
using the following procedure.

2. Turn the PC on and start Windows. If Windows does not automatically start,
enter WIN at the MS-DOS prompt to start Windows. For additional details on
starting Windows, see your Windows documentation.

3. Insert the 3.5" SDDS Setup Software installation disk into drive A or B.

4. In the Windows Program Manager, choose the Run command from the File
pull-down menu. In the Command Line box, type a:install if you inserted
the installation disk in drive A. Type b:install if you inserted the installation
disk in drive B.

5. If a previous version of the SDDS Setup Software is already installed, the
installation software will display the following list of options.

De-install - Removes the currently installed version of the SDDS Setup
Software from the system. The SDDS file directory and
existing project files are not removed.

Upgrade - Replaces orﬂy the SDDS program files that have changed
since that last installation of the software. The existing
SDDS.INI file and project files are not overwritten or removed.

Eull - A full installation is performed. (see step 5). Any project files
found in the current SDDS installation directory will be copied
to the new file directory.

Choose the appropriate option. If de-install or upgrade is chosen, the specified
action is performed and the installation software will terminate. A pew_SDDS
program group will be installed in the Windows Program Manager (if the
upgrade option is chosen). See Getting Started for details on how to execute
the software.

5 If this is the first time the SDDS Setup Software is being installed on the
system or if the Full option is chosen in step 4, the following installation
display is presented.
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Welcome to the SDDS Setup
Software Installation Procedure
Version 1.3

 Installation Setup

Enter name of directory
where software is to be lc:\:dd: ]
installed:

G SotwaraN oAl

Soutce Drive:

Installation Status

File being procested: N\A

Percent in:lanalipn compleled: 0%

| Enter :laation d'ucry. xocedtakil!llio buttan ]
Enter the pathname where the software should be installed (default is c:\sdds).
If the source drive is incorrect, enter the disk drive designation where the
installation disk resides (default is A:) |If using the keyboard, TAB to the
respective fields and enter the data. To start the software installation, click the
Install Software Now button (or if using the keyboard, TAB to the button and
then press the ENTER key). The installation software will then copy the SDDS
program files from the installation disk to the specified directory. The installation
procedure should take approximately 2 minutes. The SDDS Setup Software
requires about 1.5 Mbyte of hard disk space. Once the installation is. complete, a
SDDS program group will be active in the Windows Program Manager.
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4, DE-INSTALLATION

Use the following procedure to remove the SDDS Setup Software from the PC.

1. In the SDDS program group, double click the mouse on the SDDS install
icon.

2. The installation software will display the following list of options.

De-install - removes the currently instalted version of the SDDS Setup
Software from the system. The SDDS file directory and
existing project files are not removed.

Upgrade - only replaces the SDDS program files that have changed since
that last installation of the software. The existing SDDS.INI file
and project files are not overwritten or removed.

Eull - a full installation is performed. (see step 5). Any project files found
in the current SDDS installation directory will be copied to the
new file directory.

Choose the de-install option. The SDDS program files will be removed. In
addition, the SDDS program group icon in the Windows Program Manager will
also be removed. The installation software will then terminate. <\

5, GETTING STARTED

Once installed (see Installation), the software is started by selecting the SDDS
program group in the Windows Program Manager. The SDDS program group
includes the SDDS Setup application icon. If you want the SDDS Setup
Software to automatically execute every time Windows’ is “started, copy the
SDDS Setup icon to the Startup program group in the Program Manager. For
more information regarding the Startup program group, see your~ Wiridows
documentation.

Starting SDDS Setup Software using the mouse Using the mouse or trackball
pointing device, double click the SDDS program group. Place the mouse or
trackball over the SDDS Setup icon and double click the left mouse button.

Starting SDDS Setup Software using the keyboard Hold down the CTRL key
and press TAB until the program group's title bar is highlighted. Press the
ENTER key. Hold down the CTRL key and press TAB until the SDDS Setup
icon is highlighted. Press the ENTER key.
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Once the SDDS Setup Sofﬁware icon has been selected, the main SDDS Setup
screen will be displayed
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] onflg Tgols Master Jest Status Help

o
0

Channel Mute Status

o Eovd Fovr e Goos Bow [Eoag (ory (SO

Left Lelt/Cntr  Center Right/Cntr  Right Sub Left Swr  Right Sur Mastor

Channel Level Trim \'Channel [W Surround Delay T

[EQ Bandt 31.5 Hertz = 0.00 dB Boost ]

Not Connected to the DFP

5.1 OPERATIONAL OVERVIEW
The SDDS Setup Software Main Display is divided into four components -
Main Menu Bar (top of the séreen)
Mute Channels Selection (upper screen)
Channel Adjustments (middle screen)
Status Bar (bottom of the screen).

> ST = ... SDDS System Setup - Project Title: New Project = 7o = LR
File Config Tgols Master Test Status  Help

MAIN MENU BAR (located across the top of the display) contains pull-down
menus for project file management (File), configuration management (Config),
adjustment utilities (Tools), master control adjustments (Master), and test signal
generation, film ECC statistics and monitoring utilities (Test). The main menu
also contains the Status menu for monitoring the operational status of the DFP,
and a pull-down Help menu containing on-line help.
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Channel Muto Status

bR (s (Ee (e (e (BRN
Right Sub

Left Lolt/Cntr Centor  Right/Cntr Left S Right Sw Master

MUTE CHANNEL buttons (located underneath the Main Menu Bar) are used to
toggle on and off the mute status of individual channels. The Master Mute
button is provided to mute all channels simultaneously. The Master Mute button

mirrors the operation of the Mute button located on the front face plate of the
DFP-D2000 processor.

Sutound Delay Trm

40 63 100 160 250 400 630 1K 16K 25k 44X 63Kk 10K 16K

5K
slekiEEREEEREREEEEEREEEE E"
|o|o|u]ulo]o[o[o]u[o]o]o]o]u]o]o]o]u]o]o]n[n[o]o[n]0[0[0‘]
High Pasz - Channel EQ Low Pas:
[ Oon R
[EQ Band: 31.5 Hertz - 0.00 dB Boost ]

CHANNEL ADJUSTMENTS (Middle portion of the display) For each channel
(except the subwoofer), the channel level trim, high and low pass filters, and EQ
Band settings can be adjusted using the controls located on the main display.
Additionally, the left and right surround channels have adjustable digital delay
trims. The subwoofer channe! allows adjustment of level and high pass filter
only. Whenever an adjustment is made, the software updates the new_setting in
the processor (if connected). ‘ '

JHot Connected to the DFP Lol B Test OFF Juniinked]

STATUS BAR (located at the bottom of the display) provides information
regarding the operation of the software and DFP hardware. By default, warnings
are displayed on a yellow background and errors are displayed on a red
background. These background colors can be changed using the Config pull-
down menu in the main menu bar.
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5.2 SUGGESTED SDDS PROCESSOR ADJUSTMENT

The DFP is adjusted by first connecting to the DFP processor, starting the test
signal generator and then setting the appropriate operational parameters using
the adjustment controls located in the SDDS Setup Software display. n
addition, non-channel adjustments (i.e., projector setup, matrix mode, etc.) are
made using pull-down menus located in the main menu bar (top of the screen).
Once the adjustments have been made, disconnect from the DFP (using the
Config pull-down menu) and then exit the software using the Fiie pull-down
menu.

6. CONNECTING TO THE DFP

Communications with the DFP are established using a RS-232c¢ serial interface
protocol. A Null Modem cable is connécted between the serial port of the PC
and the RS-232¢ port on the back of the DFP processor. The following is the
specification for the RS-232c Null Modem cable. The following diagram
indicates a 25 pin configuration for the PC Connector. This connector mustbe a -
serial port not the typical 25 pin paralle! port found on PC’s.

PC to DFP Direct Connect Cable Configurations

PC Connector DFP Connector
D-Sub Tonnector D-Sub Connector
25 Pin 9 Pin
Female Male
] 1
XD 2 R P 2 RxD
RXD 3 3 TXD
DSR 6 4 DTR
sG 7 5 SG
DOTR 20 8 DSR
crs 5 ¢ 7 RTS
RTS 4 P> L_B_ cTs
. 9

p—
Note: not shown in order |

Seral Port Only

D-Sub Connector D-Sub Connector
9 Pin 9 Pin
Female Male
] Y [y

™D 3 2 RXD

RXD 2 {4 S 3 TXD

OSR 6 [ R! 4 OTR

scs Y& s s

DTR 4 IHI »{ & DsR

cTs 8 7 RTS

RTS 7 P 8 CTS
o Lo

Note: not shown in order
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Once the SDDS Setup Software is running and a Null Modem cable is connected

between the PC and the DFP, establish communications with the DFP using the
following steps.

EEUTE Tools  Master
. Connect to DFP...
Dialup Modem Connect to the DFP...

g Projector Adjustments...

Set DFP Date/Time...
Set Matrix Mode...

Test Status

Change Display Colors... >

1. In the SDDS Setup Software display use the mouse to select Config (or ALT
- C if using the keyboard) from the main menu bar at the top of the display. A
menu of options will be displayed. Use the mouse to select the Connect to
DFP menu option (or if using the keyboard, press the C key).

2. A port connection screen will display connection options. The factory default
settings will be COM1 & Serial Number 00000.

[ Port
I @ cou
O cou2
O cou3
QO coM4

DFP Serial Number:

3. If COM1 is not the correct serial port, select the appropriate port by placing
the cursor over the desired port and pressing the left mouse button. |If
keyboard input is used, TAB to the currently selected port and use the UP
and DOWN cursor (arrow) keys to select the desired port.

4. The correct DFP serial number must be used to ensure that
communications with the DFP processor can be established. If the
current DFP serial number is incorrect, place the mouse cursor into the DFP

Serial Number input field (or TAB to the field), enter the correct number and
press ENTER.
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5. If settings were changed, use the Save Config button to save the new
configuration. This will be helpful in the future when connections are made to
the DFP. If the keyboard is used, TAB to the Save Config button and press
ENTER.

6. The Test button is used to test the existence of the specified port. If you are
unsure that the port selected is valid, use the Test button. The software will
display a message indicating the availability of the selected port.

7. To establish the connection with the DFP, use the Connect button. If using
the keyboard, TAB to the Connect button and press ENTER. The software
will then establish communications with the DFP. Connection status
information will be displayed in the status bar at the bottom of the main SDDS
Setup display. '

Once communications with the DFP have been established, the software checks
to see if a project is currently opened (see below). If a project is not open, the
software polls the DFP to determine the current DFP operating environment and
the display is updated to reflect the current settings. If a project is currently
opened, a message box will be displayed. You will be given the option to allow
the software to poll the DFP and overwiite the current project settings in the
software or you can have the software reset the DFP to reflect the current project
settings.
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7. FILE MANAGEMENT

Theater specific DFP adjustments and settings can be saved in project files.
These project files contain data and theater information that can be used to reset
a DFP to a prior operating condition. Project files are particularly useful for
resetting DFPs that have: been reconfigured due to a firmware or hardware
upgrade. Associated with each project file is a text file containing theater specific
information (i.e., theater location, technician name, etc.) and general comments.

File management is handled by the File pull-down menu located on the main
menu bar at the top of the SDDS Setup Display. Use the mouse to access this
pull-down menu or if using keyboard input, simultaneously press the ALT and F
keys. The following project file options are available (if using keyboard input,
press the underlined key to access the specified option).

New - Use this option to create a new project. The following display will be

presented.
= NS IRE RS
Enter name of p«oied:] J Theater Namo: l’i J
En(ecnaueolptoiodﬁc:[::j Screen Number: r ]
Technician Name: [ ’ ] orpsmisuu-be;—.[::]
Curront Date: Thu 12/15/34 S Site Modom N;—ber_[— J

Enter information in each field. You must enter a project file name. All other
fields are optional. If using keyboard input, TAB to each field, enter the
information, and press the ENTER key. The current date is based on.the PC
clock and is not modifiable. ‘

Comments regarding theater setup, firmware upgrades, observations and
general comments can be added to the project file. To add comments, use the
Project Comments button to gain access to the Windows Notepad editor (if
using keyboard input, TAB to the button and press ENTER). Once in the editor,
enter project related information and then use the editor’s File pull-down menu to
exit the application. Windows will automatically retum control back to the new
project display.
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When finished entering information, use the OK button to save the information to
the project file. Once created, the project name (or the project file if the project
name was not entered) will be displayed in the title bar at the top of the SDDS
Setup Software display. If you use the CANCEL button, the information entered
will not be saved and no project file will be created. If using the keyboard, TAB
to OK or CANCEL button and press ENTER.

QOpen - Open an existing project. The following display will appear listing the
projects in the current working directory.

File Name:
lT. 3dt
bikman_ tds
carygmt_sds
cooper.zds
dentwin_sds
frank._sdz

sanfranl_ sds
santmon3._sds

screenb.eds -

List Files of Type:

*

Driyex:

{SDDS Files (~.1ds)

lﬁ [;c ms-dos_6 li_l

Either select the desired project from this list or select a different directory for
additional project files (for keyboard input, use the TAB and UP/DOWN cursor
keys to maneuver through the dialog box and the ENTER key to make a
selection). The default file extension for project files is .sds.

If an existing project is currently opened or if connected to the DFP, you will be
prompted to determine if the current DFP settings should be overwritten.

Selecting YES, the opened project will update the display to reflect the new
settings and, if connected to the DFP, the new settings will.be sent to the DFP.

Selecting NO, the opened project will not update current DFP settings and the
next Save or Close operation will cause the settings in the opened project to be
overwritten with the current DFP settings.

Close - Close the currently opened project. The current DFP settings will be
saved to the project file. *Note* the software still retains in memory the DFP
settings even after the project is closed.
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Project Info: - Update project information. This option is only available if a
project is currently opened. The following project information display will be
presented.

R S R LT TR

Namo of project [ | DFP Serinl Number:  [goooo
Technician Naoe:[ l Site Modem Number: :l
Custent Date: Sat 12717794

Thoater Na-c' [

Screen Number: [

..............................................................

Make the necessary changes to the project information (for keyboard input, TAB
to the desired field, make the changes and press ENTER).

To update project comments, use the Project Comments button. The software -
will open the appropriate project text file and place you in the Windows Notepad
editor. Enter comments and then exit the Notepad editor. Windows will retumn
control back to the Project Information display.

When finished entering information, use the OK button-to save the information to
the project file. [f the project name was updated, the new project name will be
displayed in the title bar at the top of the SDDS Setup display. If you use the
Cancel button, the information entered will not be saved. If using the keyboard,
TAB to OK or Cancel button and press ENTER.

Save - Save the DFP settings to the currently opened project file. When making
adjustments to the DFP, periodically save the DFP settings to the project file.

cte PO
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SaveAs - Save the current DFP settings to a new or existing project file. To
select a project file, the following display will be presented.

academy.sds . C
tin2.xd © c,\ ;
contin{.sqs

dontwin. sds =)

newyoik3.sds %Mt’ 3

. b

3 holp }

y

Save File as Jypo: Dayer: !

[SDDS Fes (-edr) [ [mic | :

Enter a new project name or select the desired project from this list or select a |

different directory for additional project files (for keyboard input, use the TAB and
UP/DOWN cursor keys to maneuver through the dialog box and the ENTER key
to make a selection). The default file extension for project files is .sds.

If the specified file is new, the current settings are automatically saved. In
addition, the following project information display will presented.

v OO OO0 OSORONCOONN0
2N I QEHLBELODONO O a4
et ...0.."':"..'.""’.'.'.’.’.’."’.’..‘.Q’ ."...“‘,J .J.-".‘ .‘ ’.'" ..! "."

P'..'...'.."‘.".."......
R R R R R e R XU
'.‘ .'""..........‘.........‘............’... Ol

J DFP Serial Number:
] saouodo-uml:j

Name of project: r

Technician Nano:l
Cuniont Dateo: Sat 12717734
Theater Name: r

Scieon Number: r

toas >y

See Project Information (above) for information on how to use this display.

If the specified file already exists you will be prompted to confirm that you want to
overwrite the existing file. 1If you enter NO, you will be returned to the SaveAs
file display so you can make another selection.

If you elect to overwrite the selected project file and if a project is currently
opened while using the SaveAs option, several options are available.

1 Save the current DFP settings and the project (theater) specific information
(i.e., project name, technician name, theater, etc.) to the specified file
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2. Save only the current DFP settings. If you elect to save only the DFP
settings, a project information display (see Project Information) will be
presented. Enter the appropriate project related information.

Exit - Exit the software. If changes have been made to the DFP settings since
the last Save or SaveAs operation, you will be prompted to save the data to a
project file. Oncé the information has been saved (or if you elect not to save the
data), the software will terminate. If you were connected to the DFP, the
software will disconnect from the DFP prior to software termination. When
disconnecting from the DFP, the software verifies (and sets if necessary) that the
mute status of all channels is off and that test signal generation is off.
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3. DEP ADJUSTMENTS

Adjustments are made by moving scrollbar controls and clicking buttons on and
off. In addition, non-channel related settings (i.e., projector setup, matrix mode,
etc.) are adjusted using pull- down menus located in the main menu bar. All
adjustments can be made using either the mouse (or trackball) or the keyboard.

“Note* If the SDDS Setup software is not connected to the DFP, adjustments
can be made on the software without the adjustments being sent to the DFP.

8.1 MUTE FUNCTIONS

By default, the mute buttons (one for each channel) are off. However, during
test signal generation (see below), one or more channels can be muted (i.e., no
test signal is generated for that channel). To guard against leaving channelsina |
mute state after making DFP adjustments, the software automatically sets the

mute status of all channels to off when the user selects the option Disconnect
from DFP.

*NOTE"* if connected to the DFP and the PC should crash or the cable
between the PC and the DFP is disconnected, muted channels will not be
reset to the off position. This will effect sound quality while a film is
running.

To toggle the mute status of a channel on and off, use the mouse to click the Q
button associated with the desired channel. For keyboard input, F1 through F8
function keys are mapped to the eight channels. Press the corresponding

function key to toggle the mute status of the desired channel on and off.

Channel Muts Status

Er e (s e (R
Right/Cntr  Right Sub

Lett Left/Cntr  Center

Left Sur  Right St Mastor

Linked Mute Channel Mode N

To aid in tuning a theater, a channel link option is available in the Tools pull-
down menu (see Tools below). This feature causes the software to
automatically mute all channels except for the currently selected channel. In
linked mute channel mode, every time a channel is selected (either by clicking
one of the channel mute buttons or by clicking the Next or Prev buttons in the
SDDS Setup Software display), the mute status of the remaining channels are
toggled on. To toggle off the mute status of additional channels while in linked
mute channel mode, position the cursor over the desired mute channel button
and press the right mouse button (if using the keyboard, simultaneously press
ALT and the function key mapped to the desired channel - for example ALT -F1
to toggle off the mute status of the left channel).
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MASTER MUTE

By default, the master mute is off. Choose this option to mute all channels.
This feature is particularly useful if all channels should be muted quickly. For
example, when generating pink noise (-20 dB) during testing, if all channels are
on (i.e., not muted), there is a high probability that theater equipment and/or
human hearing will be damaged (Note: the SDDS Setup Software makes every
attempt to avoid this situation). Using the master mute can quickly turn test
generation off to all channels Click the master mute button to toggle on and off
the master mute. For keyboard input, press the F9 function key to toggle the
master mute on and off. Note: once the master mute is on, you cannot toggle on
and off the mute status of individual channels.

Mute All Keys At Once

To toggle on the mute status of all channels, use the F10 function key. This
functionality mutes each channel individually. This differs from the Master Mute
functionality (see below) where the DFP stops sending a signal to all channels as
a group. Using F10 is a convenient way to mute all channels and then
selectively tumn on (i.e., turn mute status off) each channel individually.
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8.2 CHANNEL SELECTION

If linked mute channel mode is off (see Mute Buttons above), then the current
channel is selected using the Next and Prev buttons on the display. When a
new channel is selected, the display is updated to reflect the current DFP
settings for that particular channel. In linked mute channel mode, toggling the
mute button for a.particular channel will automatically cause the software to
make the selected channel the current channel and the display will be updated
accordingly. For keyboard input, use the Page Up or Page Down keys to select
the next or previous channel.

Channel Level Tnm Channel

8.3 CHANNEL LEVEL TRIM

Left

This control allows adjustment of the output level of the currently displayed
channel. This adjustment is relative to the Master Level Control (see Master ’
Settings). Any change in Master Level will simultaneously adjust all channels
accordingly. For critical adjustment of channel level, make certain the Master
Level Control is in the desired position..

To make level trim adjustments, position the mouse cursor on the scrollbar and
drag to the desired setting. For keyboard input, press a lowercase | and then
use the UP and DOWN arrow (cursor) keys to make the adjustments.

8.4 SURROUND DELAY TRIM

This control is only active with the two surround channels. It provides access to
the digital surround delay available in the DFP. :

To adjust the delay trim, position the mouse cursor on the scrollbar gnd drag to
the desired setting. For keyboard input, press a lowercase d and then Use the
UP and DOWN cursor (arrow) keys to make the adjustments.

8.5 EQ BAND SETTINGS

Adjustments to the 28 octave bands (31.5 Hz to 16 KHz in 1/3 octave steps) can
be made for each channel except the sub-woofer. Adjustments between -10 dB
and 10 dB can be made on each band. To adjust a band level, position the
cursor over the desired band and use the left mouse button to drag the scrollbar
to the desired setting (the band will be highlighted in red - the default highlight
color).. For keyboard input, use the right or left cursor keys to position the cursor
over the desired band Use the UP and DOWN cursor (arrow) keys to set the
control to the desired setting.
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8.6 NOMINALIZE EQ BAND SETTINGS

Adjustments to all 28 octave bands (for the currently selected channel) can be
made. In the Tools pull-down menu (see below), select the Nominalize EQ
Bands option (or simultaneously press ALT and n if using the keyboard). A
display will be presented allowing you to specify the adjustment to add to all EQ
bands for the currently selected channel. The software has a built in upper and
lower bounds to prevent you from specifying an adjustment that will cause one or
more EQ band settings to exceed the -10 dB to 10 dB window.

8.7 HIGH PASS FILTER

For each channel (except the sub-woofer), the high pass filter frequency can be
set. For the currently selected channel, position the cursor over the high pass
filter scrollbar and drag to the desired filter setting. For keyboard input, use the
right or left cursor (arrow) keys to position the cursor on the high pass filter

scrolibar (it will be highlighted). Use the UP and DOWN arrow keys to adjust the
filter setting. '
High Pass
(T Y

| 68 Hz

8.8 LOW PASS FILTER

The low pass filter frequency can be adjusted for each channel. For the currently
selected channel, position the cursor over the low pass filter scrollbar and drag to
the desired filter setting. For keyboard input, use the right or left cursor (arrow)
keys to position the cursor on the low pass filter scrolibar (it will be highlighted).
Use the UP and DOWN arrow keys to adjust the filter setting. The default low
pass filter setting for the sub-woofer is 330 Hz. When generating test signals,
the SDDS Setup Software will automatically set the low pass filter setting for the
sub-woofer to 330 Hz, unless a lower setting is selected (see Test Signal
Generation below). :

tve ERPSRd

- Low Pazz
15.0 kHz

8.9 EQ ON/OFF

Adjustments to the EQ bands for the currently selected channel are stored in the
memory of the DFP. However, for the settings to take effect, the EQ ON/OFF
checkbox must be checked (On). To toggle the EQ ON/OFF box, position the
cursor key over the checkbox and use the left mouse to toggle the box. For
keyboard input, use the F12 function key.

Channel EQ
‘ Oon I
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8.10 CONFIG PULL-DOWN MENU

REVISION 2

The following is a description of the menu options found in the Config pull-down

menu.

,(_:,onhg Tools Master Test Status
“Connectto DFP.., - - 0
Dialup Modem Connect

to the DFP...

Projector Adjustments...

<4 Set DFP DatefTime...
Set Matrix Mode...

Change Display Colors... 4

TOOU Ul T

8.10.1 CONNECT TO DFP/DISCONNECT FROM DFP

See Connect to DFP (above) for details on connecting to the DFP. Once
connected to the DFP, the Connect to DFP menu option is replaced with the
Disconnect from DFP. To disconnect from the DFP, click this option (if using
the keyboard, press D). A message will be displayed to confirm that you want to
disconnect from the DFP. [f you elect not to disconnect, the software retumns
control to the main SDDS Setup Software display. If you elect to disconnect, the

SDDS Setup Software verifies that the mute status of al

| channels are off, the

master mute is off, ECC statistics collection is off (see Test), and that there is no
test signal being generated. If any of these settings are incorrect, the software
sends the appropriate’commands to the DEP to ensure these conditions are met.
Once disconnected, the software replaces Disconnect from DFP with Connect to

DEP in the Config pull-down menu.
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8.10.2 DIAL-UP MODEM CONNECT TO THE DFP/DISCONNECT FROM DFP

Connection to the DFP can be established through a dial-up modem. Contact
your SDDS representative to determine if you have the correct DFP Processor
firmware version to support modem connections. When choosing this option (if
using the keyboard, enter D) the following display is presented.

PP O00O00O00C .).‘."...o’o T aToeoigh TaposTeTat & SR R Se0co igs oyt Tely
R GO PP e A T G I A PO S

[ Modem Port

[com1 | @ICoMT|

O cou2
O cou3
O comM4

I A T KK K,

DFP Serial Number:

Nodo-P’chwbec[N/A ]

NI T e N T X T I T I R O XX,
R . K A S

-

By default, COM1 is the serial port where the modem is connected and 00000 is
the DFP serial number. If COM1 is not the correct serial port, position the mouse
cursor over the desired serial port and press the left mouse button. If using the
keyboard, TAB to the currently selected port and then use the UP and DOWN
cursor (arrow) keys to select the desired serial port. ‘Enter the correct DFP serial
number (if using the keyboard, TAB to the serial number field, enter the serial
number and press ENTER). To dial the modem connected to the DFP, enter the
phone number in the Modem Phone Number input field. To save the information
for future use, use the Save Config button. The Test button is used to verify
that the selected serial port exists. If an invalid port is selected, a message will
be displayed indicating the error. Choose another port and try testing again. To
connect to the DFP, use the Connect button. . e
When connecting to the DFP, the software initializes the PC modem (i.e.,
modem connected to the serial port on the PC) and then sends a dial-up
command containing the modem phone number supplied by the user. During
the initialization process, you will experience some delay before the actual
dialing takes place. This delay is a built-in factor that ensures that the software
will communicate with most Hayes compatible modems. Monitor the status bar
at the bottom of the screen for messages indicating the status of the initialization
process. Once initialized, dialing will start and the following message box is
displayed.
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TR ENT r—r_
b beP0%0c0 0 0 0001 2 F 12
y ...0...0"..‘..5. il Rt N

Disking: 5555555
Connect Statux: Attesepting Connect....
Tima 1omawning to connect: 58 seconds

The software has a sixty second time envelop in which an attempt is made to
establish connection with the DFP. If a connection is not made within the sixty
second time slice, the software will abort the process and return control back to
the Connect to the DFP using Modem Dial-up display.

If a modem connection is established with the DFP and no project is currently
opened (File Management above), the software polls the DFP to determine the
current operating environment. During this polling process, a display is
presented indicating the polling status. Once the DFP operating environment
has been determined, you are now ready.to make adjustments to the DFP
settings.

if a modem connection is established with the DFP and a project is currently
opened (File Management above), you will be given two options. You can
either update the DFP to reflect the settings of the currently opened project or
you can poll the DFP and overwrite the settings of the currently opened project.

In either case, some delay will be experienced as communications between the
PC and the DFP take place.

Once connected to the DFP, the software replaces the Dial-up Modem Connect
to the DFP entry in the Config pull-down menu with Disconnect from the DFP.
To disconnect from a modem connection, choose Disconnect from the DFP
from the Config pull-down menu (or press Dif u'singftig keyboard). A message
will be displayed to confirm that you want to disconnect from the DFP= If you
elect not to disconnect, the software returns control to the main SDDS Setup
Software display. If you elect to disconnect, the SDDS Setup Software verifies
that the mute status of all channels are off, the master mute is off, ECC statistics
collection is off (see Test below), and that there is no test signal being
generated. If any of these settings is incorrect, the software sends the
appropriate commands to the DFP to ensure these conditions are met. After
verification, the software disconnects from the DFP and then sends a hang-up
command to the local modem. There will be a time delay as the modem hang-up
operation is performed. Once disconnected, the software replaces Disconnect
from the DFP with Dial-up Modem Connect to the DFP in the Config pull-down
menu.
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8.10.3 PROJECTOR SETUP

Master Sync Delay This setting adjusts the amount of delay the DFP will
introduce to assure that the SDDS digital sound track is in sync with the picture
and analog sound track. This setting is calculated in frames and should be set
while listening to a film sound track. The DFP provides a headphone monitor
connection within the unit for listening to both the analog aid digital center
channel tracks simultaneously. Refer to the SDDS DFP installation manual for
further information. To change the projector sync delay, select Projector Setup
from the Config pull-down menu (if using the keyboard, simultaneously press the
ALT and C keys to get the Config puli-down menu and then press the P key).
The following display will be presented.

p

I B M x e .

To make an adjustment, position the cursor over the scrollbar and drag to the
desired setting. The new adjustment will be sent to the DFP. If using the
keyboard, TAB to the scrollbar and use the UP and DOWN cursor (arrow) keys
to set the desired sync value. When finished, click the Done button (or if using
the keyboard, TAB to the Done button and then press ENTER).
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8.10.4 SET THE DFP DATE/TIME

The current DFP date and time can be set using the SDDS Setup Software.
Select Set DFP Date/Time from the Config pull-down menu (if using the
keyboard, simultaneously press ALT and C to gain access to the Config pull-
down menu and then press S). The following display will be presented.

. ""’.”""..-"-‘-'-""'."""'.'."'
P A B K R R A5 S0
e e A P 5 B RO R SRR A X

Howrs and Minutes (HH:MM} [N/A ]

Date (MM/DD/YYYYY [ J

Enter the appropriate date and time in the format specified (if using the
keyboard, TAB to each field and enter the information). If the current PC date
and time is correct, use the Use Current Time button. Click the OK button to
send the new date and time to the DFP. if you select CANCEL, the DFP date
and time is not updated. :

'§.10.5 SET MATRIX MODE - ¢

The SDDS Playback Processor can be configured to produce several output
configuration options. By selecting the desired output configuration mode, the
DFP can be used in a variety of theaters having different channel configurations.
To select a matrix mode select the Set Matrix Mode from the Config pull-down
menu. If using the keyboard, simultaneously press the ALT and C keys to gain
access to the Config pull-down menu and then press the’M key. The following
display will be presented. :

‘g L

QOO M YA X RIXIDC0 Q
....... N ISRzttt te et e B

Matrix Hode

@ spoS

l 0701Channolx
Q 6 Channohs
QO 5 + 1 Channels
QO 4 Channoiz
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Choose one of the following options (if using the keyboard, TAB to the matrix
selection box and use the UP and DOWN cursor (arrow) keys to make the
desired selection).

SDDS Mode This format will provide a 1:1 mapping of the 8 channels on the film
to the 8 output channels.

SDDS Full Range Format QUTPUTS

Inputs L tC | C | RC R | SW| LS | RS

1 Left X

2 Left/Center X

3 Center : X

4 Right/Center X

5 Right X

6 Sub Woofer . X

7 Left SurroLmd - - -X

8 Right Surround : X
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7 + 1 Mode This format will provide a stereo surround format with 3 full range ’
speakers behind the screen and baby booms. C

70MM Format w/Stereo Qutputs
Surrounds ’

Inputs L lw!| clrc] R |SW]| LS |RS

1 Left ’ X

2 Left/Center X X

3 Center X

4 Right/Center X X

5 Right | - X

6 Sub Woofer X t X X

7 Left Surround X

8 Right Surround : X (
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6 Channel Mode This is a standard 70MM, baby boom sound format with mono
surrounds.

70MM Format w/Mono Qutputs
Surrounds ‘

Inputs L LC C RC R | SW| LS | RS

Left ’ X

—

2 Left/Center X X

3 Center X

4 Right/Center . X X

5 Right X

6 Sub Woofer X X X

7 Left Surround X

pas

8 Right Surround
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5.1 Channel Mode This format provides 3 screen channel, stereo surrounds,
and sub woofer. ('\

Phantom LC & RC Qutputs

Inputs L LC C RC R Iswi| LS | RS

1 Left X

2 Left/Center X X

3 Center X

4 Right/Center X X

5 Right X

6 Sub Woofer X

7 Left Surround ' X

8 Right Surround e S X
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4 Channel Mode This format provides 3 screen channel, mono surrounds, and
an optional sub woofer.

—r—

Standard Stereo Optical Qutputs
Format

l—

lnputs L LC C | RC R |sw]| LS | RS

1 Left " X

2 Left/Center X X

3 Center X

4 Right/Center - X X

5 Right X

6 Sub Woofer X

7 Left Surround X

8 Right Surround : X

page 29 02/15/85



SDDS SETUP SOFTWARE USER'S MANUAL _ REVISION 2

8.10.6 CHANGE DISPLAY COLORS

The following are the default colors (as shipped from SDDS) for the SDDS Setup

Software. :
white background color of the displays
green ‘background color of the scrollbars
red scrollbar highlight, background of error and alert messages
yellow background of warning messages
gray background of buttons

Use Change Displdy Colors in the Config pull-down menu to change the
default colors (if using the keyboard, simultaneously press the ALT and C keys to
gain access to the Config pull-down menu and then press h). A popup menu will
be displayed with the following entries.

Scrollbar Color changes the default scrollbar color

Scrollbar Highlight Colorchanges the default scrollbar highlight color

Button Color changes the default button background color
Window Background changes the default window color

Alert Status Color changes the default error and alert background color
Warning Status Color  changes the default warning-background color

After selecting one of the above entries (if using the keyboard, presé the
underlined key and then press ENTER), the following display will be presented.
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Select the desired color and click the OK button (if using the keyboard, TAB to
the desired color and press ENTER). The selected color will become the defauit
color for the particular control from now on.
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8.11 TOOLS PULL-DOWN MENU

The following is a description of the menu options found in the Tools pull-down
menu.

AR Master
- Copy Chaf..
Beset Chan...

Test

Status

Help

Upload New Program Code...

Restore DFP...

Link Mute Channels te Channel Select
Nomalize EQ Bands...

1« Compare Project...

X TRy ThIl Faetll ATRT UIJ Th

8.11.1 COPY CHANNEL

Channel settings (i.e., trim levels, EQ bands, high/low pass filters, etc.) can be
copied from one channel to another. To copy channel settings from one channel
to another, select Copy Chan from the Tools puli-down menu. If using the
keyboard, simultaneously press the ALT and O keys to gain access to the Tools
pull-down menu and then press C). The following display will be presented.

o OO Oy Aﬁ R OCOOOQOOCIOOR MR
) 00 (X ';’ &5 ;..‘..'..000000.
3~ a9 e % % s s V85", % 3‘33'.' “‘“:‘.,.".l...A.O.A.Q.A‘.’O“’l‘.‘b‘

Sl D

Left Surround
Right Surround

p ISctec( Channet to Copy From J

Copy Options p e

. [
@ Al Oplons QO EQ ON/OFF :
O Thannel Trim O EQ Band: S
O Channel Delay O High and Low Filters b

3
P
P

BOL OB

Select the “From” channel from the list on the left side of the display (the
selected channel will be highlighted). Select the desired channel (the “To”
channel) where the channel settings will be copied from the list on the right side
of the display (this selected channel will also be highlighted).
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To perform the copy operation, use the Copy button. Once the Copy button has
been activated, a message box will appear warning you that the DFP settings of
the “To" channel will be overwritten. If you elect to cancel the operation, the
software will retum you to the main SDDS Setup display without performing the
copy operation. If you elect to carry the operation out, the DFP settings of the
“From” channel will be copied to the “To” channel. To copy the DFP settings to
additional channels, select another “To” channel from the list on the right of the
display and perform the same steps just described.

Copy Options By default, all channel settings are copied from the “From”
chanrel to the “To" channel. However, copy operations where only a subset of
the DFP channel settings are to be copied can be performed (i.e. Copy EQ
bands only). To select a subset of the channel settings, position the mouse over
the desired setting (at the bottom of the Copy Chan display) and press the left
mouse button. Continue selecting setting options until the desired subset is
selected. Now use the Copy button to perform the operation.

When finished copying settings from one channel to another, use the Done
button to exit the display.
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8.11.2 RESET CHAN

Channel settings can be reset to SDDS specifications. The following are the
default channel settings as shipped.

0dB for all EQ bands

OFF | high pass filter setting

OFF low pass filter setting (330 Hz if sub-woofer)

-10 dB : channel level trim

0 msecs surround delay trim (for surround channels only)
OFF EQ switch (if ON EQ bands are adjusted in DFP)

To reset the settings of a channel, select the channel using the Next or Prev
buttons (Channel Selection) and then select Reset Chan from the Tools pull-
down menu. The following display will be presented.

Pa¥: %Y

PARIEN

QO Delay

O EQ IN/OUT

O EQ Bands
C)thjnwF?q:

!

............... R AR HOORRROI IS

Either all channel settings can be reset or a selected subset can be defined. To
reset all channels, position the cursor over the All Settings option and press the
left mouse button. If a subset of settings is desired, position the cursor over the
desired setting and press the left mouse button. Continue this operatior until all
settings have been selected. To reset the settings, use the Reset button. Once
the Reset button has been activated, a message. will be displayed warning that
the selected settings for the current channel will be overwritten. If the user elects
to cancel the operation, the software will retum you back to the SDDS Setup
display and the reset operation will be canceled. If the user continues the reset
operation, the selected channel settings will be set to the defaults and control will
be retumned to the main SDDS Setup display.
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8.11.3 UPLOAD NEW PROGRAM CODE €q\
New firmware (supplied by your SDDS representative) can be uploaded to the '
DFP. To upload a new firmware version, select Upload New Program Code
from the Tools pull-down menu. The following display will be presented.

- DFP Program File File Tranzfer Status

Blocks Transferred: N/7A of approx. 0000
New DFP Program File: Percent of File Transfeaed

L Il

Est. Time to Completion: 0 mnutot

® Cowbined Files (af files)
QO DSP lnstructions Only
QO DSP Coelficients Only

s ~ Program Uploading Options | !
O CPU Program Only E

To upload a new program file, you must enter the full flename (including the
directory pathname) of the program file supplied by your SDDS representative.
To obtain a list of available program files, use the Filename button to access the
Open New DFP Program File display.
' (
3 .

e S R RRRRRRARRRRARR
by
File Name: Dixoctonex:
[~.hex "] ei\sompredda3 A
verl T hex =0 E
ver20Lhex © o0y X
£y 3dds13 3
C3 does :
£ help O Bead Onty
S X
»
1
List Files of Jype: Driyesxc ) .
[HEX Fios hex) | - i } ’

Select one of the liéted program files (default extension is .hex) or selecta
directory to display additional program files.

Program Uploading Options By default new DFP program files are shipped
with the CPU program, DSP coefficients and DSP instructions combined into one
file. However, there are occasions when the shipped file contains only one of
the aforementioned components. If the selected program file only contains one
of the three components (you will be notified by your SDDS representative if the
shipped program file contains only one component), select the appropriate
option in the Program Uploading Options box. To select an option, position the
cursor over the desired selection and press the left mouse button.
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Start Uploading Once the program file and uploading option has been selected,
use the Start button to start the uploading process. Once the start button is
activated, the software calculates the number of blocks of data to transfer and
the estimated time (in minutes) of completion. In addition, the Start button
becomes the Stop button. As the program file is uploaded, the percent of
completion is displayed in the flow bar on the New DFP Program Upload display.
To Stop the uploading process, use the Stop button (the Stop button now
becomes the Start button). To continue the uploading process, use the Start
button.

When Canceling the uploading operation, the DFP automatically disconnects
from the PC (you will be notified via a-message box). Use Connect to DFP in
the Config pull-down menu to reconnect to the DFP. Note: if you prematurely

cancel the uploading process, the DFP continues to operate using the old
program firmware.

Once the complete program has been uploaded (a process that can take up to
30 minutes), the DFP performs a verification pass on the new program file (which
is stored in temporary storage). The verification process takes approximately 5
minutes to complete. Once the verification process has finished, a message
asking to reboot with the new program code appears. At this point, the old DFP
program code is still operational. However, once the DFP is rebooted, the old
program code is overwritten with the new program. If the user elects not to
reboot the DFP, the DFP will disconnect from the PC. Use Connect to DFP in
the Config pull-down menu to reconnect to the DFP. If the user elects to reboot
the system with the new program code, the DFP overwrites the old program
code with the new program code, disconnects from the PC and then reboots the
DEP. Use Connect to DFP in the Config pull-down menu to reconnect to the
DFP running the new program code.

Problems If communication problems occur during the uploading process or if
during the verification pass the DFP determines that the program data is__
corrupted, the software will display an error message and the DFP will
disconnect from the PC. Use Connect to DFP in the Config pull-down menu o
reconnect to the DFP (which will be running the old program).
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8.11.4 RESTORE DFP

When a connection is first made with the DFP, the current operating state of the
DFP is saved in memory. To restore the DFP to the state that existed prior to
connecting to the DFP, use Restore DFP in the Tools pull-down menu. (If using
the keyboard, simultaneously press the ALT and O keys to access the Tools pull-
down menu and then press E)) When selecting Restore DFP, the following
display is presented.
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Select yes to restore the original DFP configuration (if using the keyboard, TAB
to the yes button and press ENTER). If you select no, the DFP settings are not
restored. If yes is selected, a message is displayed warning that the current
settings in the DFP will be overwritten. If the user elects to cancel the operation,
the software will not send the stored configuration to the DFP.

8.11.5 LINK MUTE CHANNELS TO CHANNEL SELECT

When generating a test signal (see Test below) and making adjustments to the
DEP settings, it is convenient to link the mute button keys to the channel select
operator (see Channel Select above). When the mute buttons are linked, the
software will automatically mute all channels except for the currently selected
channel. When a channel is selected (either by clicking one of the channel mute
buttons or by clicking the Next or Prev buttons in the SDDS Setup Software
display), the mute status of the remaining channels are toggled on. To toggle off
the mute status of additional channels while the mute buttons are linked, position
the cursor over the desired mute channel button and press the right mouse
button (if using the keyboard, simultaneously press ALT and the function key
mapped to the desired channel - for example ALT -F1 to toggle off the mute
status of the left channel).

Unlink Mute Channels to Channel Select When selecting Link Mute
Channels to Channel Select (if using the keyboard, press L), the software
overwrites the menu entry with Unlink Mute Channels to Channel Select. To
cancel linked mute channels, select Unlink Mute Channels to Channel Select. If
using the keyboard, press u.
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8.11.6 NOMINALIZE EQ BANDS

Instead of individually adjusting each EQ band, a nominal adjustment can be
made to all EQ -bands at once. To make a nominal adjustment, select
Nominalize EQ Bands from the Tools puli-down menu. If using the keyboard,
simultaneously press the ALT and O keys to gain access {0 the Tools pull-down
menu and then press the N key. The following display will be presented.

3.0 0. 0.0 0.0 0.0
XA
Y Setatetetytatete!

For the currently selected channel (see Channel Selection), Use the mouse to
position the scroll thumb to the desired nominal value to add to each EQ band. If
using the keyboard, TAB to the scrollbar and use the UP and DOWN cursor
(arrow) keys to position the scroll thumb. To add the nominal value to the EQ
bands, use the Execute button (if using the keyboard, TAB to the Execute button
and press ENTER). The settings for the EQ bands will automatically be
adjusted. To exit the display, use the Exit button (if using the keyboard, TAB to
the Exit button and press ENTER).

When Nominalize EQ Bands is selected, the software automatically calculates a
range of acceptable nominal values that can be added to the EQ bands. The
upper and lower bounds of this calculated range will be displayed atthe.top and
bottom, respectively, of the nominal value scrollbar. These bounds are used to
prevent a nominal value from being chosen that when added to a particular EQ
band setting, causes the new setting to be set outside the allowable -10 dB to 10
dB range.
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8.11.7 COMPARE PROJECT

Select Compare Project from the Tools pull-down menu to compare the
settings of an existing project with the current DFP settings (if connected to the
DFP). If using the keyboard, simultaneously press the ALT and O keys to
access the Tools pull-down menu and then press P. This function is particularly
useful to verify that the current DFP settings have not changed since the
previous tuning session. Since this function compares the settings of an
unopened project file with the current settings in the SDDS memory, this function
can also be used to compare the settings of two projects. To do this, make sure
the software is not connected to the DFP (see Disconnect from the DFP), open
a project and then use Compare Project to select the other project.

When Compare Project is selected, the following display is presented.
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To select a project to compare settings, use the Select Project button (if using
the keyboard, TAB to Select Project and press ENTER). The following display
will be presented.
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Select the desired project file (or select another directory for additional lists of
project files). 'If using the keyboard, TAB to the desired project filename or
directory and press ENTER.

Once a project file has been selected, you can either compare the channel
settings or compare all settings. If you choose Compare Channeis Only,
differences in the level trim, surround delay trim, EQ band settings, and the high
and low pass filter settings between the selected project and the currently
opened project (i.e., the current DFP settings if connected to the DFP) will be
displayed. Since theré are eight channels of information, several screens of
information may be displayed depending on the number of differences found.

If you elect to choose Compare All Settings, the aforementioned settings are
compared as well as the current projector master sync delay setting, master level
and lip sync settings, analog/digital bypass setting, and the matrix mode are also -
compared. As with Compare Channel Settings, several screens of information
may be displayed depending on the number of differences found.

em g
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842 MASTER PULL-DOWN MENU

B0V 7 SDDS System Setup> Project Tilecew Project 3.2 =zt

Ell Qon Tgols Master Jest Status Help

To set the master level, lip sync, and the analog bypass select the Master pull-
down menu (if using the keyboard, simultaneously press ALT and the M keys).
When Master is selected, the following display will be presented.

i Beteleledolodeletolo s leled QRRLELRR00) o FE

R SR P I I IO I o o'h"c'o'c?»’o'o‘ ST RO I o K M ]
L2 ntetele 0 e v e 0 n e 0 ¢ 0L W 20, vy
[:‘ *aa%" .’-}'-»‘3‘:‘33‘-'.95'-.'.'. loYa’a’2%a%"%"

[~ Master Gain—l [ Fine Frame Delayj [ Analog Bypasz ™|

@ On
O ot

8.12.1 MASTER GAIN

The master level control can be adjusted either from the front panel on the DFP
or from the master setup display. To adjust the master gain, position the mouse
over the master gain scrollbar and move the scrollbar thumb to the desired
value. If using the keyboard, TAB to the master gain scrollbar and use the up
and DOWN cursor (arrow) keys to position the scrollbar ,thumb to the desired
value. It is important to note that this adjustment can be altered by the front
panel control or any SDDS remote unit at any time. It is good practice to set this
control to 0 and then trim the individual channels to produce the nomiridl level
per channel in the auditorium. The master gain is intended as an overall level
control for the theater.

*Note* Since the master gain can be adjusted from the front panel of the DFP,
the SDDS Setup Software periodically polls the DFP to determine the current
Master Gain setting.
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8.12.2 FINE FRAME DELAY

The fine frame delay is intended to allow precise adjustment of the lip sync
between digital tracks and the picture. This adjustment is a fine control in
contrast 1o the master sync delay (see Projector in the Config pull-down menu)
which provides course adjustment. To adjust the fine frame delay, position the
cursor over the fine frame delay scrollbar and move the scrollbar thumb to the
desired position (value). If using the keyboard, TAB to the find frame delay
scrolibar and use the UP and DOWN cursor (arrow) keys to position the scrollbar
thumb at the desi'red value.

8.12.3 ANALOG BYPASS

The analog bypass allows manual control of the bypass relays within the DFP.
In normal operation, these relays work automatically, however during setup it
may be desirable to manually switch between analog and digital signals. It is
possible to activate the bypass relays manually using the front panel switch on
the DFP. To toggle the bypass switch on and off, position the cursor over the
desired setting and press the left mouse button. If using the keyboard, TAB to
the current setting of the analog bypass and use the UP and DOWN cursor keys
to select the desired setting. When disconnecting from the DFP the bypass
control is returned to OFF to assure proper automatic operation of the DFP.
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8.13 JEST PULL-DOWN MENU

To facilitate the tuning of a theater, test signal generation and channel
monitoring setup are provided. In addition, a utility is provided that is used to

monitor and collect ECC error statistics being performed by the DFP processor
while a film is running.

Al Status  Help

- Signal Generation...”:
Monitor Control...
ECC Test...

8.13.1 TEST SIGNAL GENERATION

To generate a test signal, select the Signal Generator from the Test pull-down
menu. The following display will be presented.
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Select the desired test signal (pink noise, 100 Hz tone, 1 KHz tone and 10 KHz
tone) and level (0 dB, -20 dB, -90 dB.and Off) from the options listed it the"
display. If pink noise is selected, the 0 dB and -90 dB test levels are not
available (grayed out). To turn test signal generation off, set the test level to Off.
When a test signal is generated, the name of the test signal generated is

displayed in the test signal status box at the bottom of the SDDS Setup Software
display.

Disconnected - PINK . * (R
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As long as a test signal is being generated, the test signal status box will
continue to display the name of the signal. When disconnecting from the DFP,
the software will make sure test signal generation is off. If a signal is being
generated, the software will send the appropriate message to the DFP to turn
test signal generation off.

Use the Done button to exit the DFP Signal Generation display. If a test level
other than Off is selected, the test signal will continue to be generated even
though the display is gone.

Signal Routing Once a test signal is generated, the channels where the signal
is 1o be routed must be selected. From the list of channels or the right side of
the DFP Signal Generation display, select (and unselect) the desired channels to
route the signal. If you want to route to all channels, use the All On button. To
unselect all channels, use the All Off button. The All Off button is convenient {o
use when you want to route to only one channel and there are currently a
number of activer channels. Use All Off to unselect the channels and then select
the desired channel.

Mute Status and Signal Routing Although a channel is selected for signal

routing, the signal will not be heard if the desired channel is currently in a mute
state. Make sure the mute state of the selected channels are off.
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8.13.2 MONITOR CONTROL

The digital signal generated (either in testing or when a film is running) can be
monitored by plugging. a headphone set into the left monitor jack of the DFP
(located behind the front panel). To select what is sent to the left monitor jack
select the Monitor Control command which is found under the Test menu. The
following display will be presented.
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Select the desired monitor location from along the digital signal path and then
select which channel combination you want to monitor. The signals will be sent
to the monitor headphone jack in stereo. To adjust the level, use the control
located next to the headphone jack on the circuit card. NOTE: not all of the
channel combinations are available for a particular monitor location. If an invalid
combination is chosen, a message box will be displayed indicating that an invalid
configuration has been selected.
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8.13.3 ECC TESTING

The SDDS Setup Software can be used to monitor ECC error correction while a
film is running. This feature is useful for determining the quality of a film print.
For example, poor sound quality in a theater may be due to a worn print rather
than a poorly tuned auditorium. Using this feature to target a worn print will
prevent re-tuning the theater. To monitor ECC error correction, select ECC
Testing from the Test pull-down menu (if using the keyboard, simultaneously
press ALT and E keys to access the test pull-down menu and then press E).
The following display will be presented.
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When a film is running, the DFP reads and processes digital data from both'the
P and S tracks of the film. Error cormrection is performed on the data to ensure
the highest quality sound signal. However, from time to time, the data read from
a sound track is so corrupted that error correction cannot improve the sound
quality. When this occurs, the DFP falls back to Digital Concealment Mode
(DCM). Since the digital data on the S-track side of the film lags the
corresponding P-track side by approximately 17 frames, the DFP will use the P-
track data (which is stored in memory) whenever a DCM occurs while reading
the S-track. As long as the P-track data stored in memory is error free, the
sound quality of the print is high. However, if the P-track data stored in memory
is also corrupted (while the DFP is in DCM due to S-track failure), both sources
of digital data are corrupted and the DFP falls back to Analog Concealment
Mode (ACM). When the DFP is in ADM, analog data is sent to the channels.

ECC Filename Since DCMs are a measure of film quality, the film address (film
footage and frame) for a track where a DCM is detected is saved to file. This file
can than be analyzed to determine the quality of the print. By default, the error
file is named error.txt and is created in the current working directory (where the
SDDS Setup Software is installed). If a different filename is desired, enter the
new name and press ENTER (if using the keyboard, TAB to the ECC Filename
input field, enter the filename, and press ENTER).
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Start Polling To start polling the DFP for DCM error correction statistics, use
the Start Polling button (if using the keyboard, TAB to the Start Polling button
and press ENTER). If the ECC Filename already exists, the software will display
a message giving you.a choice to overwrite the file or cancel the current
operation. |f you electto cancel the operation, the software will return control
back to the ECC Testing display where you can enter another filename. If you
elect to overwrite the file, the following display will be provided.
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Use the Start button to start collecting ECC data (the software will replace Start
with Stop). The software will continue to poll the DFP until the Stop button is
pressed. The quality bars in the display will be filled with color indicating the
stage of error correction for the current film footage. When the top level bars are
red, a DCM has occurred. At this point, the software records the film footage in
the error file specified earlier. Normally, the first level bars (Excellent) are filled
(green) indicating normal operation of the DFP. However, if tHe DFP is not
running a film, ECC error correction is not underway and no data will be
displayed: -

g A

To stop ECC error correction monitoring, use the Stop button. Use the Exit
button to return back to the main SDDS Setup display. If you use the Start

button again (the software replaces Stop with Start when the Stop button is

used), the software continues to poll the DFP for ECC data.
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8.14 STATUS

~i-0-8DDS System Setup - Project Title:
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File Config Tools Master Jest Status Help

To monitor the current status of the SDDS Setup software and the DFP, select
Status from the main menu bar. If using the keyboard, simultaneously press
ALT and S). The following display is presented.
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Houwrs SDDS reproduced: 0
Hours Fm running: 0

Fim Date: N/A

Fism Version: N/A
Recordor seriat N/A
Fim Commonts: N/A %

DFP System Statur: Film is nol unning
DFP Alarm: DFP Systewm is OK

Caxrent Date: Mon 12/18/34

Courtent Time: 18:45

DFP Current Date:

DFP Cuirent Time: N/A

If connected to the DFP, the DFP serial number, current DFP firmware version,
hours the DFP has been powered on, number of hours sound has been
reproduced from digital data, number of hours film has been running through the
DFP and the DFP system status will be displayed. The DFP status can be one
of the following:

Film is not running

Film is running

SDDS is reproduced

ECC rate statistics is running = e

If the DFP status is “ECC rate statistics is running”, sound quality will be
compromised and the DFP should be reset to “SDDS is reproduced”. To place
the DFP into “SDDS is reproduced”, start ECC Testing (see the Test pull-down
menu above), collect some data (i.e., several frames) and then exit ECC Testing.
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The DFP Alarm can be one of the following.

DFP System is OK

LED in the reader unit

Power for the reader unit
Cooling fan in the reader
Presence of CCD signal
V_Lock )

PLL_Lock

Cooling fan in the decoder unit

Except for the first alarm (DFP system is OK), the remaining alarms indicate an
operational problem with the DFP. If one of these alarms is displayed, contact
your SDDS representative.

In addition to the DFP status and alarms, the DFP date and time is displayed. If
DEP date and time is not the same as the current date and time, use Set
Date/Time in the Config pull-down menu to set the DFP date and time.

if a film is running, the film title, reel number, film footage, film recording date,
version number, film recorder number and film comments will also be displayed.

To refresh the display, use the Collect New System Status button. If using the
keyboard, TAB to the Collect New System Status button and press ENTER.
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8.15 HELP

~Getting Started... . -
Keyboard Shortcuts

About...

Use help to access the on-line help provided with the SDDS Setup Software.
When selecting Help (if using the keyboard, simultaneously press ALT and H), a
pull-down menu will be displayed.

8.15.1 GETTING STARTED

Select this menu entry to access help on how to get started using the SDDS
Setup Software. In addition, detail help regarding the features available in the
software can be accessed using the Contents button of Windows Help. See the
Windows documientation for more information on using Windows Help.

8.15.2 KEYBOARD SHORTCUTS

Select this menu entry to get a list of the keyboard shortcuts available in the
software. Keyboard shortcuts are keyboard key sequences that are used to
access pull-down menus, maneuver through displays and make adjustments to
DFP settings. These keyboard key sequences are particularly useful for laptop
computers where the mouse or trackball dévice is missing or is inconvenient to
use.

8.15.3 ABOUT

Use this menu entry to display the following SDDS Setup Software information
box.

n SDDS System Conﬁgutalio_n

Verston 1.34beta
Authors: J. E. Taylor and M. D. Orosz

Copyright 1993-1995 SDDS

TR T XOCKTARX
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s. FURTHER INFORMATION
If you have any questions regarding the SDDS Setup Software please contact.
SDDS Labs
10100 Venice Bivd. 1st Floor

Los Angeles, CA 90232

(310) 842-4567 Phone

(310) 842-4568 FAX
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